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Welcome to NAHPA: expanding & evolving !
Contents:

Angela Garry—Editor

N

AHPA is expanding & evolving!
The first issue of the magazine
was in Autumn 2001 — and had 16
pages with an introductory article
“celebrating our school secretaries”,
reproduced here in pages 4 & 5. In
2004 the magazine grew to 28 pages,
then settled 32 pages in 2007 until
the present day. Since I became
involved with the magazine in 2010,
I’ve brought in articles from trainers
and PAs around the world, and last
year when I took ownership of
NAHPA, I vowed to reduce both the
number and size of images within the
publication, in order to make room
for more material.
Today, we take the next step forward:
NAHPA is 15 years old—and this, our
45th issue, reaches 40 pages, bringing
more insight from people working in
education, and items of relevance to
PAs and admins worldwide: plus look
for our important name change
announcement (see back page) to
take the magazine further in the
future!
Please email editor@nahpa.org.uk
with any further
suggestions
for
NAHPA.
Onwards and
upwards!
Best wishes to all,
Angela Garry
ISSN 2397-1932 (printed issue).
NAHPA magazine is owned and published by
Angela Garry, trading as Pica Aurum.
Registered office: 10 Sydney Road, Draycott,
Derbyshire, DE72 3PX, UK. Tel: +44 1332
874327. © Angela Garry & NAHPA 2016.
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The A-Z of this issue’s contributors:
 Carol Bailey is PA to Headteacher at Poole Grammar School,
England.
 Terri Fishbourne is an Executive Assistant who has worked in
schools and industry for 20+ years in the USA.
 Anel Martin is an award winning former PA, now full time
trainer and coach who is passionate about assistants and the
valuable work that they do.
 Nasreen Nanji is Executive Secretary to the All School /
Administration Director at the International School of
Tanganyika, Tanzania.
 Claire Sarris is an SSAT lead practitioner in community and
engagement, linking schools with the world around them.
 Ingrid van der Weide is a versatile event organiser with 20+
years experience across corporate, charity and community
events incorporating sponsorship, sales, fundraising, marketing,
communications and operational functions.
 Teri Wells has 30 years experience in the PA profession and is
an international speaker, trainer, facilitator and mentor "with a
passion for giving back to the profession that I love".
Regulars:
 Andy Case is a cartoonist, illustrator and music mogul by night,
and talented teacher by day.
 Tandy Hanff is our resident in-house IT guru and self-confessed
geek), with 20 years’ self-taught computing experience.
ALL REMAINING ARTICLES:
 Angela Garry is NAHPA’s editor, author of “Brave PAs”, and a
global PA Trainer, with 24 years’ experience in admin & PA roles.
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Networking / Resources / Survey
There’s an enormous range
of resources out there that
could help you enormously
in your role — just a small
effort once a week on your
part can make all the
difference!

THE NAHPA discussion
group on LinkedIn
All NAHPA subscribers are invited to
become members of the discussion
group and new members should
receive an email to join the group
shortly after they’ve subscribed to
the magazine. (If you have not
received this email, please contact
editor@nahpa.org.uk). On receipt of
the message, click the link to join the
group—and, if necessary, create
yourself a free user registration on
LinkedIn.
“OK, I’m on LinkedIn. Now what?”
1. Join groups that are directly
connected to the work you do, the
work you want to be doing, and
causes that light you up and spark
a passion. LinkedIn Groups
provide individuals with similar
interests to post, share, and even
converse on topics and issues in
which they are interested and
about which they want to share
information. A good rule of thumb
is to strive to participate in
LinkedIn Groups about once a

week. Find great content and
share it appropriately. (Make sure
you have read the content, so you
know what it says.) The NAHPA
group is specifically JUST for
NAHPA subscribers, and is set as a
“private” group—which means
that whatever is discussed or
posted in the group remains
private to the group members
only—the contents of messages
are not searchable via engines
such as Google.
2. Engage members of your Group
by asking a question. Sometimes
individuals will post provocative
questions to spur a debate or
discussion. Be careful not to be
too provocative…you could get
yourself in trouble…but asking if
members of the group have been
successful pursuing a particular
strategy or program might spark
some conversation that could
benefit the entire group–not just
you. If your question or post is
relevant to more than one Group
to which you belong, then post to
all of them. Be mindful, however,
if you belong to a lot of Groups.
You don’t want to be flooded with
responses all at once.
3. You can change your settings for
each and every single group for
which you are a member—to
determine whether you receive
daily, weekly or NO messages
from the group via email. (To do
this, click the small cog symbol at
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the right side of the group’s name,
to go into your settings page for
that group.)
4. Be conscious of the fact that you
are building a personal and
professional
brand
when
participating in Group discussions.
Be courteous, be thoughtful, and
contribute in a positive way in
every post and every interaction.
LinkedIn isn’t like Facebook where
individuals sometimes let their
emotions get the better of them as
they engage in political or
philosophical
debates
or
discussions.
LinkedIn
is
a
professional venue, and the tone
should always be respectful and
professional. Keep your snarky
remarks to yourself. (I wouldn’t
recommend
posting
snarky
remarks on Facebook, either, but
we have seen that in abundance
along with hastily posted and
sometimes
hastily
withdrawn
Tweets that were formulated in the
heat of the moment. LinkedIn is
definitely not the place for
rudeness or sarcasm.)
5. One source of great content is
LinkedIn’s very own ‘Pulse’ section,
which is helpful because LinkedIn
uses your profile page to determine
your interests. When you click on
Pulse, you will see the various
articles that LinkedIn thinks you
might find of interest. When you
find something that warrants being
shared, feel free to like the article,
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comment on the article, and share
it with one or more of your
groups.
6. Don’t be afraid to put yourself
“out there” - ask questions, post
your own answers to other
people’s questions, comment on
articles that are posted by others.
Don’t just view the space as a
“chat board” - see the discussion
group as a valuable source of free
resources to help you with your
job, by learning from the expertise
of others, and a fantastic space for
you to share your knowledge and
experience with them in return.
Even if there are only twenty
members in a group with 5 years’
experience each in their roles, this
adds up to a hundred years of
knowledge and expertise that you
can draw upon—and some groups
have
many
thousands
of
members.
An increasing number of PAs these
days are offering Virtual Assistant
(VA) services from their homes in
spare time—some with the intention
of switching to part-time in their day
jobs, others with a view to moving to
full-time working from home for
themselves. If you’re in this situation,
you could use your participation in
LinkedIn Groups to drive up your
online visibility and presence in hopes
of creating more traffic and the
possibility of business, and to learn
from other VAs out there.
Share valuable content, and as
people come to know, like and trust
you, they will gravitate toward you
and may become your next client or
customer naturally. You have to let
them come to you, however, so guard
against the overly promotional
post or self-promotional discussion
in your next Group post.
LinkedIn is a great resource for
professionals and it provides a
powerful way for entrepreneurs to
find leads, prospects, and clients. It is
also a great place for sharing valuable
information, however, that advances
contemplative discussion, thoughtful
sharing, and even collaboration.
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Nurture your LinkedIn network and
build an online reputation (brand) as
someone who brings value to every
conversation in which you participate.
Understanding LinkedIn and using it to
your advantage will be well worth the
time and effort you put into building
your relationships within your Groups.
Suggestions of Groups to join:
 NAHPA
 Global Education Administrators
 International School Administrators
 PAs, EAs, Vas and Senior Admins
Each of these groups will put you in
touch with PAs working in (in the first
three groups) education and in PA
roles throughout the world. The fourth
group is enormous, with around
75,000 members globally, so there’s
even more chance of finding the
elusive answers to your burning workrelated questions!

“I don’t have time to read
LinkedIn or this magazine
or networking in general!”
Don’t think that all of this has to take
an enormous amount of your time—if
you just put aside 10 to 15 minutes per
week to have a look at what’s been
posted recently by other PAs on
LinkedIn, this will keep your finger on
the pulse of much of what’s going on in
the global PA community.
Let me ask you a question: do you
normally arrive at work, 10- 15
minutes before you are due to start
working? If yes, then you do have time
to look at LinkedIn at least once per
week. Or: do you take your full lunch
break every day, or do you return to
your work a few minutes early? If yes,
set those few minutes aside to look at
a LinkedIn group, one day per week.
And: do you find it difficult to find time

to read this magazine each term? If
yes, then don’t try to do it all in one
go! Just aim to read an article or two
per week. Use a post-it note as a
bookmark, to mark where you’ve got
up to in the magazine, so that next
time you pick it up you can quickly skip
to the last page you read and continue
reading from there.
Continuous Professional Development
is EXACTLY that—continuous. Little
bits of learning here and there.
Having been a busy PA in a school
myself, I know for sure that almost NO
school PA or Admin tends to have a
spare hour per week to spend on
anything. That’s why I suggest a few
minutes here and there. Learn in
snippets, use the knowledge you gain
throughout your week.
You’ll be surprised how quickly a few
snippets can add up to increase your
knowledge, build your skills-base,
further your expertise, grow your
confidence, etc.!

The NAHPA Survey 2016
We asked — and you are answering.
The results of the NAHPA 2016 survey
are still being collated.
Several readers have asked for more
time to submit their responses, so in
order to give more of you a chance to
respond on the survey from the last
issue, we are extending the respondby date til 31 July 2016.
You can download the survey from
www.nahpa.org.uk/files/Download/
NAHPASurvey2016.pdf — fill it in and
then scan / photograph the pages and
email
your
responses
to
editor@nahpa.org.uk
Three respondents will be picked out
at random and will be awarded a copy
of “Brave PAs: the ultimate guide to
being outstanding in a tough job” by
NAHPA Editor Angela Garry. So get
your responses in!

Please send your NAHPA 2016 Survey responses in:
3 at random will be awarded a copy of “Brave PAs”.
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NOTE:
More dates set for
London (Sept),
Birmingham (Nov)
and Leeds (Dec
2016) - contact
Osiris Educational
for details.
Quote code
ANG116,N,PAA,B
when booking.
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Revisiting NAHPA’s first issue
As the magazine increases in size for the first time in over ten years, we look back at the very
first issue’s opening article, to see what, if anything, has changed...
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Revisiting NAHPA’s first issue

← NAHPA insert: Minister of
State (Education and Skills)
(Schools), Jun 2001 - May 2002

How much has the role of school PA or Administrator changed
and moved forward in YOUR school in the last 15 years?
NAHPA Issue 45 / Summer 2016
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Tackling difficult conversations
Last year’s Hays PA survey
showed that over 40% of
PAs / EAs in years 0-4 of
their roles are responsible
for managing staff.
However, the average age at
which a manager in the UK
receives any training in how
to manage people is 42—
meaning most of us are left
finding our way in the dark.
Carol Bailey, PA to the Head
at Poole Grammar School,
shares some suggestions
from her career on how to
hold difficult conversations
with colleagues that you line
manage.
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“When I first started as a very naive
Headteacher’s PA nearly 20 years
ago, the job was quite basic. I was
essentially a secretary with no other
responsibilities or authority, used to
doing the Headteacher’s bidding and
making his tea or coffee!
Since then the role of Headteacher’s
PA has been recognised as an
important and senior position in most
schools. Along with this recognition
has come more responsibilities and
opportunities to line-manage other
colleagues and oversee the running
of different departments.
Although
I
relished
these
opportunities and actually think I
made quite a good job of them, the
most difficult for me was having to
have what is generally known as a
“difficult
conversation”
with
someone.
In the early days I was guilty of
putting it off, thinking it would go
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away or resolve itself. The first lesson I
learned was that it doesn’t go away, it
very seldom resolves itself and usually
only gets worse!
So I thought I would lay out my hard
won tips for having a difficult
conversation. I don’t pretend to be an
expert and I am certainly not saying
this is the only way but I have found
that by applying these measures it has
made it easier and in most cases has
achieved the outcome I was looking
for.
First of all, when something is not
going well, or other colleagues are
complaining that something is not
done, or something has been done
but isn’t right etc., you know it is time
to have a conversation.
I have found that on the whole most
people want to do a good job at work
and there are very few that
deliberately go out of their way to be
awkward or unhelpful.

Tackling difficult conversations
So bear this in mind when a
conversation is needed: never
ambush or take someone by surprise
and then launch into a tirade about
their shortcomings!
Try to talk to someone in private and
say that you are concerned about
whatever it is you want to talk about
and suggest a meeting perhaps the
next day so you can discuss the
situation.
This gives them time to think about
what they might want to say, which
ultimately
might
make
the
conversation and resolution quicker!
Don’t schedule a meeting for several
days or weeks in the future as this
will only make the colleague worry
and ultimately be on the defensive.
At the meeting try to remain friendly
and open to solutions.
Make your position completely clear
from the outset, ask them for their
take on the situation and allow them
time to talk.
There may be something going on in
their private life which is impacting
on their working life, even though
we might all say we should keep
things separate.
In practice this is not always possible
and at least knowing what is
happening might make things easier
to deal with.
If the problem is one of insufficient
knowledge or experience, ask them
how they think they could improve.
Encourage them to recognise their
own shortcomings and what would
improve the situation.
Try to put in place training and
regular support, and be prepared to
give your own time or ask another
senior colleague to act as mentor.
If the problem is more of a
personality issue, i.e. they are having
a clash with another colleague or just
not doing the job as you would
expect it to be done, then the
solution may take longer.
Again try not to rant and “tell them
off”: nobody wants to feel they are
being disciplined.
Lay out the tasks that are not being

done and ask for an explanation. Do
this in such a way so that the
employee has the opportunity to say
why he/she has not done something:
be prepared for them to have a
completely different idea that hasn’t
been considered.
Personality clashes are the most
difficult problems to deal with, and
at the end of the day you may have
to accept that not everyone is going
to be best friends.
All colleagues must have high
expectations of how they wish to be
treated and if someone’s behaviour
falls short of this then unfortunately
the only outcome may be an
escalation to a disciplinary procedure
– which is something else entirely!
To sum up:


Don’t put off having a difficult
conversation with someone;



Be completely clear in your own
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mind on what the problem is and
what outcome you are looking for;


Allow time for a meeting, it will
always take longer than you think
and be prepared to give your own
time to help support the situation;



Take notes and schedule follow up
meetings;



Above all be respectful and kind:
we are all in this together!”

Carol Bailey has spent 18 years in
post at her school, and is due to
retire at the end of this term.
NAHPA wishes her a happy and
healthy retirement, and thanks
her for sharing some of the
wisdom she has learned in her
role.
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A quick guide
to mentoring
for PAs
Asking for help is never a bad thing –
especially when it comes to your
career. No one knows all the answers,
and it’s always of tremendous benefit
to have insight from another person.
There are a few things you must do
before you begin seeking a mentor.
Know what help you are looking for
from a mentor so that you can
identify somebody appropriate to
your needs. For example, don’t ask
someone who focuses on personal
growth to assist you if your prime
focus is to enhance a skill set (such as
using a software application).
Decide how you want the relationship
to work. Do you want a face-to-face
meeting in person, or would you be
happy to work with them via phone
or Skype, or even email? How often –
and when – are you looking to make
contact? Should it be via a scheduled
timeline, or do you want to wait for a
triggering event (perhaps a tough
situation at work)?
Have a goal in mind. You are seeking
a mentor for a specific reason – what
is it? Clearly identify the outcome so
the mentor knows how to best help
you. A goal such as “you want everyone to like you at work” is probably
too broad. Think in smaller terms
such as you want to have a better
interaction with two specific people
at work who disrespect you.
(If you are looking just for someone
to dump on, seek out a professional
or a friend who’s a good listener –
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this is not a “mentoring” situation.)
Now you’re prepared to start your
search. There are many resources
available to you.
Your own place of work. If you have
other PAs and administrative staff at
your school, you might consider
setting up an in-school mentoring
system, where you can help each
other
in
your
professional
development.
LinkedIn. When it comes to
networking professionals, LinkedIn is
the place to be! You can use the site
to make connections – and use the
discussion groups to ask questions /
answer queries. As a NAHPA
subscriber you can join the “NAHPA”
group, specifically for school PAs – or
you can join a more generic PA group
like “PAs, EAs, VAs and Senior
Admins”, to share knowledge and
expertise with other PAs around the
world.
Local PA networks. New networks for
PAs are springing up all the time –
seek out your nearest one, and find
out how to connect with other local
PAs.
Sometimes
people
confuse
mentoring and coaching. According
to Management Mentors, here are
some distinctions.


A coach is task oriented; a
mentor is relationship oriented.



A coach is short-term; a mentor is
long- term.
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A coach is performance driven; a
mentor is development driven.

In short, coaching is used when there
is a well-defined goal that is based on
improving skills and performance.
Mentoring is valuable for career
development,
providing
general
guidance, setting and achieving goals,
making decisions or facilitating
problem solving.
Finding a mentor is like building any
relationship: use your judgment (i.e.,
do not take the first person who
comes along), determine if there’s
chemistry, validate qualifications, and
have some flexibility. Again, a mentor
is not someone upon whom you can
foist all your problems: they are a
professional, trying to help you.
A good mentor will:
M – Motivate you to accomplish more
than you think you can.
E – Expect the best of you.
N – Never give up on you or let you
give up on yourself.
T – Tell you the truth, even when it
hurts.
O – Occasionally kick your butt.
R – Really care about you and your
success.
Look for people with these qualities
when you are searching for a
mentor—and do your best to embody
them yourself when you are
mentoring others.

The art of event management
Ingrid van der Weide has
many years of experience as
an event organiser—both as
a member of her children’s
schools’ PTAs and also
within her own job at
leading event co-ordinators,
MashMedia.
So you’ve been tasked with
organising the next event! How
exciting. This is your opportunity to
create the most enjoyable and
memorable experience for your
attendees regardless of the type of
event, the scale of the event or the
target audience.
The real skill of the event planner is
not to run around ragged doing
everything yourself. It is the ability to
draw upon the wealth of experience
and willingness of those around you
to help you deliver the best possible
event and achieve your objectives.
But first, make sure you understand
the objectives of the event:






What is the purpose of this event?
Who is it for?
Where will it be?
When will it be?
What do you want attendees to

come away with?
 What elements do you need to
consider?
 What budget do you have?
And so on… There’s always 101
questions.
As a veteran of two Parent & Teacher
Associations spanning a 10-year
period, and a career in event
organising across the corporate and
not-for-profit sectors, the range and
scale of events I have worked on has
been incredibly diverse.
The common factor across all events
has been the satisfaction of walking
away knowing that you did all you
could to make each event a success.
Success, of course, comes in all shapes
and sizes and that doesn’t mean there
haven’t been any disasters along the
way or things you could have done
better. You always have to start
somewhere and you always learn
something along the way.

The team approach
Event organising is far more enjoyable
and rewarding when you’re working
with a team to share the workload
and bounce ideas with.
So look around you to see who has
relevant experience, enthusiasm, time
and will be resourceful. Look inside

and outside your immediate circles
and try to include some of your key
target audience to give you great
insight into the things they like or
dislike, how to engage with that
audience sector to ensure the best
possible turnout and to give you
ambassadors within your target
audience to help spread the word. If
your event has multiple target
audiences then a representative of
each target audience will help you get
the best results.
There is no rule to the number of
people you need to create a team – it
rather depends on the type of event,
the scale of the event, the number of
stakeholders involved in the event
and whether it is a public or a private
event. You can always add to the
team along the way.

Team engagement
Getting your team as excited about
the event you’re planning as you are is
key.
Get everyone together for a
brainstorming session and gather as
many ideas as possible. Accept every
idea at the outset as the free-flowing
exchange of ideas can encourage
some
fabulous
opportunities,
experiences and results.
Before you begin the more sobering
task of narrowing down the ideas,
explore how could you make that
most fantastic outrageous idea work,
who could help you make that idea
work.
Put all your ideas together and
present them to your boss or whoever
you need to before you get carried
away with too many plans.
Once you have the go ahead, put
together your event plan, what you
need, when you need to have it by
and who is going to do what.
Communication now becomes crucial
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The art of event management
to keep your team, stakeholders and
your authoritarians in control.
Regular updates on where you’re at,
what the plans are coming to fruition
and what you’re still working on will
continue to build the buy-in.

The art of delegation
As an event planner there is a natural
desire to keep the jobs you love and
delegate the jobs you hate.
Break down all your tasks into
manageable chunks and you will be
surprised at who is willing to do what.
A good event planner will delegate a
lot of the jobs they love as chances
are they’re the ones that everyone
else likes too.
It’s OK to keep some of them as you
also have to be enjoying what you’re
doing too and for any job you hate,
find a friend to do it with. It’s never
so bad when you’re sharing the pain.
When delegating any task always try
to be as clear as possible on what
your team member or volunteer will
be taking on. What you want them to
do, the timescales needed and what
outcomes they need to achieve.
It could be as simple as reporting
back at the next meeting with the
information required and then if
there is agreement, for them to carry
out the task. People are generally
happy to do whatever is asked of
them if they know what is expected
of them.
Christmas and Summer Fairs have
always been a great example of
teamwork especially where the
different stalls are delegated to the
different year groups or classes.
Other nifty tips include a quick scout
of parent emails to see who works
where. Never under estimate the
power of parents! They are almost
always a fantastic engaged human
resource.

When a child spends 5-7 years at any
one school both in primary and then
in secondary schools, parents usually
want the best for their child.
If your event is going to enhance their
child’s experience at school they will
go the extra mile to help make that
happen.
Of course, that will not be every
parent. Some are time poor, so prefer
to make donations. Some are cash
poor, so prefer to donate their time.
Some are excellent networkers so can
point you in the direction of what you
might be looking for.
Some will have direct experience in
tasks you’re looking to fulfil and some
will work for companies and
organisations that may provide you
with products and services.
A lot of employers will favour causes
recommended by their employees
and a lot of larger corporations have
corporate
social
responsibility
initiatives
to
incentivised
by
employee engagement. For example,
HSBC actively encourages employee
volunteering and will match raised
funds or give grants for worthwhile
projects.

No budget, don’t worry

Events cost money! Of course they do
but there are so many ways around of
achieving elements of your event
without it having to cost the earth.
Bartering, fundraising, begging and
borrowing can all generate amazing
results.
Local organisations, particularly those
that are targeting local residents or
families, are only too happy to offer
products and services in return for
promotion:
 Your local flower shop may be
willing to donate bunches of
flowers or table decorations in
return for an advert in the event
programme.
 Local estate agents will pay for
display advertising boards with
your event on them in people’s
front gardens.
 The local supermarket or Off
Licence / liquor store will give you
goods for a hamper.
 The local printing company will
often print your programme or
flyers free of charge if they can
have an advertisement in return.
Mufti days, where students can turn
up to school out of uniform for £1 can
often generate hundreds of pounds
(depending on the size of your school,
of course). Holding an auction at your

What events might you be involved in? Awards ceremonies, open
evenings, Prom, Christmas / summer fairs, fund-raising activities...
12
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The art of event management
event can often generate hundreds
upon thousands of pounds.

diaries, invitations, newsletters and
so on.

event what you needed to. Then it’s
satisfaction all round.

Partnering with local community
organisations such as cubs, scouts,
brownies, sea cadets, football clubs,
rugby clubs or even other schools can
often provide you with your
additional equipment requirements.
Most things can be sourced. You
should simply not be afraid to ask.

Ensure you use a variety of mediums
and regularly repeat the messages.
Most people need to see things three
times before they respond and make
it as easy as possible to sign up.

Thank you

Nor should you be afraid to negotiate
on any quotes you have received.
Having always used the rule of three
quotes you can more often than not
negotiate down the most favoured
supplier. Asking if that’s the best
price they can offer can also yield
pleasantly surprising results.

Promoting your event
Now that the event planning is well
and truly underway, take some time
to think about how you are going to
get your attendees to come to your
event.

There are so many online tools that
can take a lot of the administrative
work off your hands. Online ticket
sites, fundraising sites, venue search
sites, app builders and more.

Like clockwork
As the day of your event draws near,
make sure you have your checklist of
what needs to be done when.
Methodically go through your
checklist each day to ensure you
haven’t missed anything.
Remember there are never any
disasters, there are learning curves
and changes of plan that happen
from time to time.

What promotional channels are you
going to use? By now, you should
already have your ambassadors who
have been busy spreading the word.

More often than not, whatever we’re
faced with, your attendees may never
need or care to know.

There are so many other channels
you can use that are low or no cost
including: flyers, postcards, social
media, online event sites, event

The most important thing is that they
leave having fully enjoyed themselves
and got out of the event what they
needed to and you have got out that
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The most important thing of all is to
remember to thank everyone who
was involved in the event in whatever
way, whether they were a sponsor,
donor, fundraiser, volunteer, supplier,
visitor, benefactor or in any other
way.
Letting everyone know how their
involvement made the world of
difference to your event engenders
goodwill for the next time.
Ask for feedback and testimonials – as
an event planner you will learn more
from what didn’t go so well than from
what did work. Constructive criticism
is incredibly powerful to institute
change and do things even better next
time.
Hopefully, you will have enjoyed the
experience so much that there will be
many next times.

If you would like any guidance or
suggestions on any events you are
organising feel free to ask the author,
Ingrid van der Weide, by emailing
ingrid@4mgsolutions.co.uk.
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Bravery is: Managing your relationship
This article is a chapter from
Angela Garry’s book “Brave
PAs: the ultimate guide to
being outstanding in a
tough job” - the only
professional development
book
for
PAs,
EAs,
Secretaries and Admins
working in education.
Bravery is: Managing your
working relationship with your
boss.
You need to be behind what your boss
stands for. Not every single little tiny
thing. You can never be that sure of
everything they do.
I mean most things– the fundamentals
– what they stand for, what they
believe in, what their aims and goals
are for the school, what their vision is
for the future of the college, what
changes and innovations they want to
bring to the university.
You need to support, respect and
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believe in your Head teacher or
Principal and what they do. If you
aren’t in agreement with what they
are working to achieve, then I’m
afraid you are working in the wrong
job.
How could you possibly provide the
best support to someone if you aren’t
behind them on what they do?
If you find that you only believe in
half of what they do, then you must
be spending 50% of your time
disagreeing with them.
That’s not going to be conducive to a
good relationship or to providing
excellent support for them – so my
rule of thumb is that you need to
believe in your boss for at least 75%
of what they say and do.
In order to provide the best support
possible to your boss, you need to
believe in them, and by doing this,
you can develop a fantastic working
relationship with them.
This doesn’t mean you are going to
be ‘best buds’, but it does mean that
you trust each other wholeheartedly
and each understands the other.

NAHPA Issue 45 / Summer 2016

The four relationship types
There are four main stages to your
working relationship with your boss.

1. Telling relationship
This generally occurs in the early
stages of your role, and also in
some junior roles, although there
are some managers who continue
in this vein for much longer.
During this phase, your manager
will tell you things: they will look at
a situation, make a decision, share
the outcome with you and tell you
what they need you to do.
It is a necessary phase as it informs
you of what is needed, to what
standard and when. However, it’s
a stage that you can, and should,
grow out of – after a while you
should be developing these skills
and decision-making processes for
yourself.
Once you have moved beyond the
telling relationship stage, it can
feel quite strange to return to it if
you change jobs because you will
have started to manage your own
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workload more.
I
experienced
the
telling
relationship stage not only early
on in my career – but also when I
moved country in 2000 and took
a temporary contract at one firm
where I was one of a team of four
PAs, one of whom had been
appointed as the Senior PA.
Regardless of our level of
experience, she insisted on doling
out work to each of us, piecemeal
and telling us in great depth what
to do with each task. To me, this
felt very restrictive and I believe
it’s a working relationship stage
that you can – and should – grow
out of.

2. Explaining relationship
This is a little further into your
working relationship when your
manager trusts you and has taken
you into their confidence, so they
will start to explain to you why
they have made certain decisions.
This builds your relationship to a
more detailed level, giving you
much more of an understanding
of what is required in your role,

including the whys and the
wherefores, rather than just being
informed that something needs to
be done.
This can prove very useful when
working on a new task or project,
when your manager needs
additional commitment from you
or when they want you on their
side to assist in ‘selling’ an idea to
other staff.
This can be a great phase to go
through: you will learn a great
deal when your boss explains
what they mean, how they are
thinking and the bigger picture as
to where things are going. It’s the
perfect environment for you to
look at your own skills and see
what you need to improve in
order to fit with the information
and understanding that you are
now gaining of the organisation.
As your working relationship with
your manager develops further,
it’s important that you keep
asking questions, finding out more
and learning in greater detail. This
is what will set you apart from the
other administrators in your

school, college or university, and
because you are continually
learning about the institution and
how your role can make a
difference.
I’ve had some great explaining
stages with some of my bosses –
helping me to really get to grips
with the whys and wherefores of
the organisation, and learning
how I could make a difference.
It’s then what you do with this
knowledge that helps you move
on to the next relationship stage…

3. Consulting relationship
This stage brings together the best
elements of both you and your
manager. It is when they start
asking you for your thoughts on
various issues, and you make joint
decisions between you.
Reaching this stage with your
manager shows that they hold you
in great trust, recognise your
expertise in what you do and
believe that you are working with
them in partnership
I spent over five years in my most
recent role – and for the first year
my relationship with my boss was
at this consulting stage, before
growing further.
What I had to say counted for
something – and that really
mattered to me. It felt really
liberating, and the working
relationship that we had grew
from there, into what I felt was a
real business partnership.

4. Empowering relationship
This is when your manager
empowers you to take free rein
over what you do and how you
handle situations, allowing you to
make necessary decisions without
consulting them.
This requires complete trust on
both sides of the working
relationship. Your manager has
confidence that you have the skills
and abilities to handle this level of
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Bravery is… Managing your relationship
additional responsibility, and
faith that you will represent
them and speak on their behalf
in the mannerisms and style that
they need you to.

make the appropriate things
happen without them having to
tell you about them, because you
have learned to anticipate what’s
needed.
 Respecting each other

I’ve reached the ‘empowering’
level of working relationship
with four of my managers
throughout my career (the two
CEOs during my four years at an
international seaport, a Deputy
Vice Chancellor at a university,
and the Principal of the
Academy) and in each of those
roles I felt an enormous sense of
satisfaction about my work, the
level of responsibility that I held,
the recognition that I received
for it, and the value in which I
was held by my manager.
It’s a remarkable feeling, and
something to really build
towards.
It is vital that you see your working
relationship with your manager as a
two-way street. Whilst you should
be aiming to have an empowering
relationship with them, the other
side of having a great relationship
with your Head teacher, Principal or
Director requires that you need to
have the courage to speak freely to
them on important matters – and
not just that they offer you the
space to speak.
Of course, if you tell your boss
something they don’t want to hear,
they may not want to listen to you.
But if you broach the subject with
them sensitively, by starting with
something along the lines of,
‘There’s something that I think you
need to be aware of …’ or ‘May I tell
you how I see something?’ they are
more likely to be receptive of your
words.
From my work with PAs in schools
worldwide, I’ve gathered lots of
hints on how to improve your
working relationships with your
Head teachers and principals in
order to better manage how you
work together.
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As I’ve said, it’s vital that you
support, respect and believe in
your Head teacher or Principal
and what they do. Without this,
how can you build rapport and
support them in running the
school or college? Everyone needs
some feedback every now and
again, so if you respect them,
honour what they say, believe in
them or find them inspirational,
let them know it!

Brave tips for managing your
manager
 Empathising
Put yourself in your Head teacher’s
position for a moment: if someone
booked back-to-back meetings for
you for an entire day, how would
you feel at the end of the day? You
will (a) no doubt be exhausted by
the end of the day but also (b) you
will have had no time to action
anything, make phone calls, send
emails or pass to your PA any
details of work that has come out
of those meetings.
So, empathise with your Head
teacher and think about giving
them a couple of short ‘breathing
space’ gaps during the day to allow
for this. This also provides a buffer
for any meetings that overrun
slightly, without kicking the rest of
the day’s schedule off-kilter.
Your Head teacher may say they
don’t need these gaps, but believe
me, once they’ve got used to
having them, they will realise how
much they need them to get things
done in-between meetings! And
for your part, the better you can
get to know your Head’s role, the
more you can just go ahead and
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My office was next door to the
Principal’s office, so he walked
through my room to get to his. If I
had a visitor in my office and my
Principal came through to go to
his room, I would always
introduce them to each other,
adding (about the Principal),
‘He’s the most inspiring person
I’ve ever worked for.’ It was a
completely true statement, and I
didn’t feel at all embarrassed
saying it. ’Give credit where
credit is due!’, I say!
 If in doubt, ask
If you are unsure about something
your Head teacher has said, ask
them for more information. And
if, after they have given some
more information, you are still in
doubt, ask again – ask for it from a
different angle so that you can
understand how best to support
them. You can help your Head
teacher to be more successful by
asking thoughtful questions to
clarify issues. Never assume and
end up making a poor decision
because you haven’t taken the
time or effort or were too
embarrassed to get the right
information. Remember, you are
working in a place of learning, and
your Head teacher is trained in
disseminating information, so they

Bravery is: Managing your relationship
should be able to explain
something in a different way for
you if you are unsure from their
first explanation, and they should
welcome that you are checking
with them when you are unsure.
 Become a manager yourself
As the Head’s PA you are in a
prime position to develop your
own role into that of a manager –
working with the school or
college’s admin team.
Ask your Head teacher to
recommend some leadership and
management books and to point
you in the direction of useful

articles.
Consider attending professional
development
workshops
or
seminars that could help you to
build your leadership skills.
Demonstrate to your Head
teacher that you would like to
learn from them how to lead,
emphasising that you can help
instil their values and ideals in the
admin team based on your close
working relationship.
Not only does this then mean that
the whole team will be working
more cohesively, with the same
aims, objectives and goals as the
Head teacher, but it also

demonstrates your competence
and your commitment to making
the school the best it can be.

“Brave PAs: the ultimate guide to
being outstanding in a tough job” is
available from Amazon.
Signed copies can be ordered direct
for £12 inc. P&P for NAHPA readers.
To order, send a cheque to the
address at foot of page 2, or email
editor@nahpa.org.uk for details on
how to pay by invoice or credit /
debit card.

Your school’s chance to celebrate you!
As a PA or administrator in a school,
you are absolutely vital in the success
of your school. You, your teaching
assistant colleagues, and all of the
other support staff in your school, you
all ensure that the Headteacher and
the teaching staff are able to go about
their daily business of educating the
children of our future.
UK–based union UNISON are holding a
special day to celebrate the
importance of school support staff.
This will be taking place on Friday 25
November 2016, from 7:00 am to 5:00
pm.

MARK IT IN YOUR DIARY!
‘Stars In Our Schools’ is set to take
place in schools across the UK. Unison
say “It takes a whole team to make a
school a safe and happy place for
children to learn. School support staff
help children learn, keep children safe
and healthy and make sure schools run
smoothly. They are the caterers, the
admin staff, the finance officers, the
teaching assistants, the librarians, the
ICT technicians, the parent support
advisers, and more. The unsung
heroes.”

ceremonies, special assemblies and tea
parties in schools across the UK to say
thank you to support staff for all they
do.
To find out more information about
how your school can be involved and
what you can do to celebrate both your
own role and those of your colleagues,
there are details available at
www.starsinourschools.uk.

award

And for those of our subscribers who
are not in the UK, why not find a way
for your school to be involved in your
own version of “Stars in our Schools”,
and help to make it a global initiative?
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Editor Angela Garry
face include giving priority to the job
in hand over other tasks that may be
pending from the previous day. In
addition, sometimes colleagues view
their job as urgent while my
supervisor has set other priorities for
me. At times, liaising with internal
departments and following up to
complete the work can be challenging
as well ensuring that the work
progresses
according
to
the
established targets and timelines.
Finally, managing visitors who arrive
without appointments can be a big
challenge.
What are the difficulties / challenges
facing your school and how does the
school address these?
We are lucky in that the school is very
supportive and does not face
challenges such as low employment
and low literacy amongst the
community we serve.
Being an
international school, we are prone to
having community members moving
on more frequently than if we were a
state school because international
teachers are able to take up
assignments in other countries and
they enjoy having the opportunity to
work in a variety of cultures. The
school faces this challenge of a
transient population by documenting
policies and procedures. In fact, part
of my work is supporting this
documentation and serving as a
resource for people who are new to
our community.

Our featured PA / Admin
For this issue’s feature,
NAHPA went to Nairobi,
Kenya! Editor Angela Garry
met Nasreen Nanji at a
professional development
event for international
school admin staff.
Nasreen works at the
International School of
Tanganyika in Tanzania.
NAHPA: Hi Nasreen. Welcome! Could
you give us some information about
your job please?
Nasreen: I have been working at the
International School of Tanganyika
(IST) as the Executive Secretary to the
Director since January 2009. IST,
established in 1963, is a private, notfor-profit co-educational day school
that offers a full educational
programme for pupils from early
childhood (age 3) to pre-university.
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The school has two campuses: an
Elementary Campus serving students
from age 3 to Grade 5 and a
Secondary Campus serving students
from Grades 6 to 12. The student
body is made up of more than 1000
students representing more than 60
nationalities. IST offers the rigorous
International
Baccalaureate
in
addition to an extensive after school
activities programme.
We're all aware that the role of
Head's PA / School Secretary is
incredibly varied, with no day
tending to be the same as the next.
What are the challenges that you
currently face in staying on top in
your role?

What are the positive influences –
where and how do your pupils benefit
from those outside the school?
We have a very active parent
community who are supportive of
creating
a
fantastic
learning
environment for the students. Some
parents take up volunteer roles on the

Every person faces challenges in his /
her role that he/she needs to
overcome and that’s all part of having
a job. Some of the challenges that I

...
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Our featured PA / Admin
school board while others volunteer
in the parent networks to coordinate
events such as talent shows, the
Global Issues Service Summit and
International Day that are well
received by the students and the
entire community.
What is the most important thing
you have learned within your role?
The diversity of the community helps
us all to understand each other and
to learn about others’ points of view.
For example, I have the chance to
help others learn about my culture
and they, in turn, help me to learn
about their traditions and culture.
Often, we find we have more
similarities than differences. In my
role, in addition to the IT and
operational skills I have mastered, I
have learned a lot about how to
address people and keep their
concerns in mind to help improve our
school’s attention to customer
service. The soft skills, such as being
polite, friendly and approachable, are
essential in my role.
How do you see your role developing
in the next two or three years?
In the coming year, my role will
expand to offer additional support to
our human resources department as
well collecting data for reports for

various key performance indicators.
Imagine the scenario – you have won
a competition and are being whisked
off for an all-expenses paid holiday
with your loved ones on Monday for
two whole weeks, with no access to
the internet or phone (so no chance
of communication with your office).
There isn't another member of staff
available to cover your role for the
full
two
weeks,
but
your
Headteacher agrees that this is a
holiday opportunity of a lifetime so
gives you the OK to go. What THREE
aspects of your role simply MUST be

carried in your absence by one of
your colleagues?
In my absence, I must ensure that my
emails are checked daily and acted
upon as required, that my supervisor’s
calendar is maintained and updated
daily, and that urgent items are
delivered to my supervisor for action
on a sometimes hourly basis.
Finally, what are you most proud of
in your role?
I am proud that one of the groups I
headed for our school’s Kaizen
programme received the best leader
award. This was an honour because
my group included people from
departments whom I don’t normally
work with and hence did not have a
strong working relationship with
before the group was formed.

Nasreen Nanji is Executive Secretary
in the Director's Office at the
International School of Tanganyika,
in Dar es Salaam, Tanzania.

If you are interested in being a
featured PA / Secretary /
Administrator in a future issue,
please get in touch!
Photo: Nasreen Nanji with her
Director, Martin J Hall
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Secret
PA
confessions
Tying in with our piece on
difficult conversations, in
this new ‘Secret PA’ feature
one NAHPA reader has got
in touch to share her story
of working with a staff
member who refused to
accept her authority.
“When I was still fairly fresh out of
University (in my mid-20s), I was
employed as a PA in a large school
where I was put in charge of the
admin office and two other
secretarial staff – one full-time, one
part-time. Both secretaries were
female and both were substantially
older than I was – in their mid-to-late
50s. The full-timer (let’s call her
Beryl) absolutely, point-blank and tomy-face, refused to accept that I had
any authority over her whatsoever.
She refused to do work that I gave
her. She refused to listen to me
when I explained that I had been
employed to run the office and to be
in charge of the team. She shouted
me down when I queried what she
was doing or how she was doing
something.
She kept moaning “I’m a proper
secretary, these idiots don’t know
what they’re doing” - referring to the
leadership of the school and their
requests for her to undertake items
of work which I soon realised she was
incapable of.
She basically bullied the other staff
into NOT giving her difficult items of

20

work to do—and had got away with
this for many years at the school
before I was appointed.
I tried cajoling her. I tried reasoning
with her. I offered training. I tried
telling her she was being difficult and
that she was making it hard for me to
run the office in the way in which I
had been appointed.
I took it higher and spoke with our HR
manager, asking for clarification and
their guidance on what to do.
Unfortunately for me, it turned out
that all the staff were terrified of this
woman – and one of the leadership
team subsequently let it slip to me
that they had specifically appointed
me to try to manage her, thinking
that maybe a younger person such as
I might be able to turn her around in
the few years she had remaining
before retirement.
They said they could back me up, but
only to a certain extent: it was down
to me to work out how to work with
her. In short, it was a nightmare time
for me – much as I loved the job and
the people I worked with, I found it
very difficult to deal with Beryl.
Finally, one afternoon I snapped and
said “I’ve had enough of this, Beryl.
You
are
acting
extremely
unprofessionally—how
can
you
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possibly keep banging on and saying
about yourself that you’re a ‘proper
secretary’ when you act like a child,
refusing to move with the times and
hiding your own inadequacies behind
shouting and bullying?”
This seemed to be the only thing that
got through to her. It felt brutal but it
was all I could do at the time. She took
a few days off to rethink her position,
and six months later she left.
This all happened just over ten years
ago when I was in my first role where I
was in charge of staff, and I’d had no
management training. Was I right?
Was I wrong? What else could I have
done? I’ve always wondered. I haven't
had a similar situation since, so I still
don’t know! How do any NAHPA
readers deal with a staff member on
their team who will not accept their
authority?”
How would you have handled this
situation and how would you have
advised this issue’s Secret PA? Send
thoughts to editor@nahpa.org.uk
If you’d like to be a Secret PA and
share a story from any area of your
experience of working in a PA /
admin role in a school, please get in
touch. Names and details will be kept
anonymous ‘to protect the innocent’.

Working with two difficult groups
As a PA, Secretary or
Administrator in a school
environment, it is inevitable
that you will be spending
time in the company of two
of the most challenging
groups of people in ANY
environment: pupils and
their parents.
For those of you who are settled into
your role, you may feel that you deal
with this challenge easily – but was it
always so?
When you first arrived at your school
you may not have worked with either
group before. Experience and
knowledge comes with time – but
what can a brand-new-in-post PA or
admin do to build that experience
quickly?
Here are some tips and experiences
collected from some NAHPA readers:

Working with schoolchildren
 “I was an only child growing up,
and we didn’t live near any other
members of my family, so there
were no cousins or kids around

apart from my school friends. This
is my first job since I graduated
and I’ve been here ten years now.
None of my friends had had kids
yet – so this was my first
experience of being in a ‘looking
after children’ role of any sort. In
the early days of my job, if I was
unsure how to deal with a child
who had been sent to me, I did
whatever I could at the time—and
then as soon as I could
afterwards,
I
asked
my
Headteacher what she would
have preferred me to do. I asked
her what sort of language she’d
have liked me to have used, what
sort of responses she’d have liked
me to give, and how I could best
represent her to the pupils. My
job was to be an extension of her,
so I needed to learn to work with
the children in the same sort of
ways that she would. She was
happy with this approach and
helped me enormously in building
my confidence in working with
children.”
 “Whenever a child has been sent
to my office to see the Head,
about 9 times of 10, he’s in a
meeting so I’ve had to deal with
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the child til he’s free. This is where
you need to have a spare chair and
some table space in your room or
wherever it is that you work, so
they can sit down. Give them pen
and paper, ask them to write what
has happened that has caused
them to be sent to you. Or give
them a book to work through—
maybe ask your Maths and English
departments to give you a couple
of spare textbooks to keep on your
shelf. “
 “I work in a primary school now,
and have previously worked in a
secondary school, and the two are
very different. I’ve found the
pupils in secondary more easy to
reason with, whilst some littler
children can be inconsolable at
times when something has upset
them: I’ve felt more of a ‘surrogate
parent’ to them at times.
Maybe
I’ve
become
more
motherly after having worked with
older pupils for a few years, or
maybe I just pity the little ones
more when they come to me
upset about something, I don’t
know, but it seems to ‘get’ to me
at a different level than it used to
with the bigger kids. It’s a small
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Working with two difficult groups
primary school and I’m a first
aider so I have lots of pupils come
to me all the time with aches and
pains and scratches and cuts and
bruises, and it breaks my heart
seeing a little child crying in pain
or upset. But I don’t feel I can be
tougher on them, even though I
was with the pupils at the
secondary school I worked out
before.”
 “Sometimes, I’ve had crying
children come to me for help. A
good way to deal with this is to
ask them their name and year
group, then say “sit there a
minute, I’ll be straight back, I just
have to deliver something next
door, then I’ll be back with you.”
Then dash next door to another
office or to reception, and ask
them to track down the child’s
mentor or Head of Year or
someone else who can casually
“drop by” your office and help out
as quickly as possible. You then go
back to the child and spend your
time calming them down a bit,
give them some sympathy and a
tissue, encourage them to focus
on their breathing. I’ve said “I
have a couple of really useful yoga
techniques for when I’m upset”
and then teach them to breathe in
for four, hold it for seven, and
breathe out for eight—then
repeat.
This change in breathing (and the
resulting change in oxygen
reaching their brain) should calm
them down fairly quickly, plus it
gives them something to focus on
rather than whatever it was that’s
upset them. With luck, the help
you’ve called for will turn up soon.
If not, give the child a pen and
paper, and like the naughty pupil,
ask them to write down what
happened. This keeps you out of
the argument / incident, and will
be useful for their mentor / Year
Head etc., for sorting things out
when they arrive.”
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Working with parents
 “In my school I’ve noticed a
marked change in the way parents
think about their children’s
education. It used to be really
important to them when I started
here in 1998 and they’d study
with the child at home—but now
there are so many electronic
babysitting
devices
(phones,
tablets, laptops, social media, TV,)
that parents seem to spend less
time helping their children to
study now and their expectations
of the school have changed. They
seem to think it’s the school that
has to do more now, even though
we’re already working harder
than ever, and many parents
don’t seem to see their children’s
learning
as
partially
their
responsibility too. I spend a lot of
my time taking calls from angry
parents who feel that the school is
failing their child, but I’ve noticed
that when I attend to take
minutes in their meetings with the
Head, they don’t seem to do
anywhere near as much with their
children in evenings, weekends,
school holidays to encourage their
learning. It’s almost like the newer
parents feel that they are
absolved from that side of things.”
 “I started working here just over a
year ago, my first job in a school.
When I came for the interview,
the Headteacher asked what I
knew of working with parents,
and I said I would treat them all
the
same,
firmly
and
professionally and calmly. He
laughed at this—and said “Oh, if
only that were possible!”. Now I
know what he meant. Yes, I can
be like that with all of the people I
come into contact with, but each
family also needs something
different that suits them. Some
need a quieter tone of voice, or a
motherly attitude from me.
Others need me to be extremely
business-like and matter-of-fact. I
deal with some of our Admissions
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and that’s an eye-opener, as it
shows me a whole other side of
some parents. I’ve had some
mums crying in my office, begging
for a place for their child when
there was absolutely nothing I
could do—the year group for their
child was full, there was a waiting
list, there was no chance of a
space—and I’ve just had to be
sympathetic and tell them we
can’t help. I’ve had a couple of
families offer me money to ‘sort
things out quietly’ - the first time
this happened the Head was in her
office next door and overheard,
and she came storming into my
room and gave the parents ‘what
for’. That was really useful—I
made note of some of the things
she told them. I’m not as firm as
she is, but I still get the points
across if anyone else tries the
same. I think that’s one great thing
about working here—I’ve learnt a
new method of dealing with
something almost every week!”
 “Parents at our school are paying a
lot of money for their child to be
educated, so quite naturally when
they phone in or come to visit the
school they often feel that their
child is the most important child in
the school. International School
parents can be really pushy and
very insistent, particularly those
from certain cultures. You get to
notice this as times goes by. It’s
good to see that they are so
concerned about their children’s
education, but it can make things
difficult if you have a parent who
phones in constantly, or keeps
visiting the building at almost
every opportunity.”
 “It’s a major part of my job,
meeting and talking with parents.
I’m their route to the Principal,
and it’s important for him that I
can protect his time—so in his first
meeting with any group of parents
he always makes a point of
bringing me into the meeting. He
tells the parents - “This is my
assistant. I trust her with

Working with two difficult groups
everything in this school. If you
need me, if you want to talk to
me, or if you want me to know
something—tell her first. She will
deal with almost everything for
you on my behalf. She has my full
authority and backing to do so
and I trust her fully. I want you to
trust her too. There are times
when I will be out and about, or in
meetings—but she will pretty
much always be around during
the day—so she should be your
first point of call if you need to
reach me.” This usually goes over
quite well, and the mums in
particular then befriend me a bit,
to try to make sure their child gets
the best care in our school.
Occasionally a parent will sidestep
this and will try to ambush the
Principal in Reception—but he will
always walk them to my office and
leave them with me to deal with
whatever they are concerned

about. Then the next time they
come in, they come straight to
me, as they know that he’ll do the
same again, so it makes it easier
for me to work with them. And do
you know what? Hearing the
Principal tell someone he trusts
me so much, on so many
occasions, has really boosted my
confidence—I feel that I can take
on almost any problem or find a
route towards solving things that I
never could have done when I
started working here.”
 “I’m still learning to handle
parents at our school. Sometimes
it feel like the Head and I are a
team-working with them: he takes
on the dads, I take the mums. I’m
more confident talking with the
mums at the moment, maybe it’s

a female thing. I still feel a bit
intimidated by some of the dads
when they phone in or visit. But
I’m working on it. It’s all new
learning. I’m in my second year as
a school PA, having come from a
corporate background before,
where I never came into contact
with customers or shareholders, so
having parents actually phone or
visit, not just write in, is still pretty
new to me. I know the friends I
have who work in PA roles in big
organisations are horrified at the
idea of having a customer
suddenly turn up in their office,
angry and irate, or upset and
worried. It just doesn’t happen in
business environments! I love that
we have contact with the pupils’
families, even if I’m still finding my
way in talking with the dads.”

If you’d like to be part of our new Readers’ Advisory Panel who we
might contact on certain topics, please get in touch!

The PA cartoon
Here’s the latest in our series on the life and times of the
Head’s PA, by talented teacher and illustrator Andy Case.
This time: the Head’s changed the voicemail system...
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The future for school admissions
As part of your role, are you
involved in Admissions for
your school? Claire Sarris
shares
her
innovative
thoughts on looking at the
admissions process in a
different way, and the future
for Admissions.
As I further push on into my (loud
cough) 30-somethingness and have
more than a demi second to
contemplate life, I have begun to
recognise and partially accept that I
may be regarded as a living
contradiction. Why? Well, thanks to
the constant presence of social media
in my life, I have a tendency to
‘publicly’ state one thing and then say
or do something that completely
dispels my mantra and allows others to
do that thing we all do in private:
judge.
For example, I really do not like
shopping. At all. I find the whole
process incredibly tedious and actually
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quite stressful. I do, on the other
hand, love to invest in a ‘positive
purchase’ (PP) or nine. Now, to make
this very clear from the outset, this is
not shopping.
No.
‘Positive
purchasing’ is that good old friend
that offers that kick of contentment
and that shot of satisfaction when
you are buying into something that
you desire, that you deserve, that you
trust and will remain loyal. ‘Positive
purchases’ will infinitely improve your
existence.
In a day and age where the
‘consumer experience’ is scored,
analysed and measured within an
inch of its life, it got my old grey
matter ticking over about my own 9
to 5. During a recent ‘PP’, I was
alerted to a prestigious brand that
‘levy’ their staff to the sum of £100
from their salary, every time they
score less than a 8/10 in a mandatory
customer feedback survey but outlay
a £50 performance bonus when a 9
or 10 is achieved. If I worked for this
noted brand, where customer
experience feedback is ‘profitable or
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penalising’, in my role as a Transition
Coordinator within an ‘improving’
secondary academy, would I be paying
my employer each month or would
my employer be paying me?
The word ‘Pan’ in my world before
September 2014 would have been
preceded with the words ‘frying’,
‘sauce’ or ‘Peter’. When responsible
for the transfer of primary pupils to
secondary education, you soon learn
that ‘PAN’ is an acronym for
‘Predicted Admission Numbers’. These
three little words are normally
represented by numerical digits – a
statistic which a Head Teacher will
first look for on the publication of the
school offers list.
Ultimately, the ‘PAN’ gleans two very
significant pieces information for a
school:
1) how many students you are to
expect in a cohort during the next
academic year and
2) how much money your school will
be receiving for those students. Chaching!

The future for school admissions
In an era of perpetual cuts and
austerity in all public services, this
bears great implication to budget
forecasts, staffing levels and so forth.
Therefore, the ‘sell’ of any educational
brand is essential from the outset. You
must go forth and ‘retail the details’;
market the ethos and highlight the
USP of the organisation to a varied but
potentially profitable marketplace.
With the imminent grey cloud of
‘complete academisation’ within the
English education system looming,
slick profit making education trusts
brandish their ‘autonomy to rule’ over
the Local Authority–asauruses, who
are regarded as dusty, archaic,
prehistoric in policy and approach.
Parents and carers are outfitted with
OFSTED judgments, league tables and
a cascade of educational reports to
ponder when choosing the right school
for their child.
The catchment battles ensue, with
some academies resorting to polished
advertising on the side of public
transport, high resolution flashinterfaced websites, wristbands, bags,
taster days, phone apps, all in the
name of high value branding, beating
their competitor and raising the
schools appeal in their catchment
market and beyond.
There always has been and always will
be those schools associated with
success, achievement, discipline and
so forth. In most cases, quite rightly
so, a good school with quality teaching
and strong leadership, where a solid
reputation rather than results can
raise the value of property within a
postcode boundary.
As with every coin, you have the heads
and you have the tails – there are
schools that sit in low aspirational
communities with a poor educational
track
records,
regarded
as
underachieving,
underperforming,
failing and often unfairly mistaken as
solely poor.
I believe good teachers and more
importantly, proactive students are
found within all schools; caring parents

with high aspirations for their children,
regardless of social background or
educational attainment exist.
Academisation was introduced to
address failure and to equip schools
with more self-regulation away from
regional control. Now, amidst the
perpetual policy change that serves
our system no favours, all schools are
now required to academise by 2020,
regardless of a school’s OFSTED status.
We must ask ‘how do we ensure that
there is a mutual ‘positive purchase’
occurring between school and
student?’ “How do we ensure that
admissions into any school are fair,
transparent and non-selective?” Will
the ‘try before you buy’ market
become more and more competitive
and will this make the whole process
detached, stressful and misleading for
families?
What matters are the foundations and
everybody’s foundations vary. Most
recently, having spent a lifetime in
professional rentals, I became a
proper grown up (or that’s what I have
been told I have to legally refer to
myself as!) and scoured the property
market to buy my first marital home.
Yep, the ultimate positive purchase
that you “will be paying for, for the
rest of your days, so choose wisely and
do some homework.” Those flippant
words from my old dad over Sunday
lunch still echo in my ear today.
This major life transition was a mere
expectation to most but secretly; I was
petrified: “what if I got it wrong?”
“what if I made a mistake?”, “what if I
my neighbours didn’t like me?”. I
mean, I knew I had a budget, certain
practical specifications and the
support of a savvy husband but really,
I’d never had a mortgage before and
solely undertaking the ‘affordability
checks’ at my bank made me cry tears
from the palms of my hands.
I’d never liaised or employed a
surveyor, structural engineer or a
solicitor and honestly, other than a
generic but limited understanding of
their roles within society, I didn’t have
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the foggiest what they did or more
importantly, what they would do for
me. When I tentatively brought this
up with my peers who had already
seemingly ‘skipped’ onto “the ladder
of doom”, this was spoken about as a
measly step in a normal process that
was beginning to keep me awake at
night. The positive purchase of a
‘dream home’ became an isolated
nightmare in my head that I began to
avoid. Ignore.
Alternate positive
purchases were sought and bought
(no shopping involved!) and if putting
my fingers in my ears were the
solution, I was already wrist deep!!
Now, relate my story to that of a
primary
pupil
contemplating
secondary school or a parent trying to
‘Keep up with the Joneses’ rather than
objectively consider the right school
for their child.
The fear of the unknown is a powerful
thing and I have witnessed time after
time the dual mirrored anxiety of
student and parent, immersed in SATS
preparation and taking their eye off of
the imminent life change ahead of
them. It is easily done.
Like the purchasing of property,
school admissions can be a longwinded, waiting game of cat and
mouse. You view in September, apply
in October, receive an offer the
following March and then your child
will most probably start their new
school in the following September
(although increasingly, more schools
are now starting their Year 7 cohort in
the July of the academic year).
The current application process from
primary to secondary education is an
essential yet disjointed and detached
bureaucratic system that involves
parents, pupils, schools and admission
authorities. Many schools now offer a
programme of ‘Open Events’ from
school tours, taster days and activity
evenings and these can begin in some
schools as early as Year 4, during the
summer term. Parents and students
are enticed into foreign buildings to
sample school dinners, perform daring
scientific experiments and have a
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The future for school admissions
staged cuppa with a prefect. Parent
visits and tours into our schools have
proved a fascinating learning curve
and eye opener; discovering the
fundamental
expectations
and
concerns of the third partner in a
school-student triangle, that will
ultimately result in a decision to shape
their child’s future.
I have stood with the biggest smile,
clutching forms and marketing
materials in the glass reception of my
own school campus, where I have
meaningfully morphed into a super
synergized ‘Agent of Transfer’. I am an
educational agent, mediator, solicitor,
negotiator and counsellor, all rolled
into one.
I have become that very person I
craved during my own positive life
purchase: I am the one who ‘sells’ but
supports; who demonstrates that it is
okay not to fully understand, it is OK
to question things, and there is no
such thing as a stupid question in this
game. I would rather the question be
asked than not at all and it is my
responsibility to create an approach
and environment to allow parents and
pupils to do this.
It is my responsibility to translate the
vision and ethos of the school; the
‘essential’ behaviour, pastoral and

academic policies – but to
contextualise that with personality,
care and attention. I want the
purchase of a school place only to be
positive. Like buying my house, I
understand the importance of
details and data – and the need to
marry this with instinct and emotion.
When I first walked up to my new
home, I knew it was the one. In the
pit of my stomach, it was for me,
albeit the most expensive property
on our ‘to view list’: but we had to
make it work.
In an era of
allegations of ‘exam factories’ and
outcome only agendas, it is
important for pupils and parents to
feel comfortable with their learning
partner: grades, like the small print,
signify achievement and progress
but to be able to apply these in life,
the school ‘home’ must also
accommodate the development of
character, resilience and passion.
And as I sit and text my interior
designer, I am continually learning,
changing my plans with my own
nest. It is our relationships with the
various ‘experts’; plumbers, builders,
designers that matter – and in the
school context, the teachers, the
support staff who constantly ‘assess
and improve’ to bolster student

progress, as you would within a house.
With everything in life, there are
strengths and there are weaknesses.
It is how you develop the relationships
with these experts that is key to
consolidating improvements, along
with the investment of time and care.
As noted in the recent OFSTED report
‘Key Stage 3: The Wasted Years’, it is
fundamental to ensure that there is
consistency and parity in the academic
and pastoral transfer of any child
through
the
primary-secondary
educational stage. All parties involved
with such a significant purchase hold a
responsibility to ensure that a student
is ‘secondary ready’.
My advice for anyone looking into the
Admissions at any school would be:
yes, use the ‘Right Moves’ of the
world; websites and glossy brochures
paint a good picture, but go and seek
out ‘the Agent of Transfer’ at the
school. Ask questions, get a gut
feeling and create a relationship with
your new school as soon as you can.
At a recent education conference in
my city, I was congratulated for a full
‘PAN’ pre-admission for the 20162017 cohort (there were only 4
schools in my city who achieved this; 3
marked as Outstanding and 1 that has
just come out of Special Measures).
The secret? Simply, people matter;
from the pupils to the parents to the
teachers. The investment in people
will build the reputation of a school
that will prove stronger than any other
brand value.
Now, I wonder if my boss will be open
to a £50 performance bonus for me
this month? – I have a few positive
purchases to make!
Claire Sarris was responsible for the
transition
arrangements
and
admissions at a 11-18 secondary
Academy in the East Midlands and is
about to take up a new role at
Groundwork Greater Nottingham as
Lead Fundraising and Development
Officer, where she'll continue working
with children and young people
throughout the region.
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Are you and your colleagues
aware that there are such
things as “secret apps” out
there, which your pupils
might be using on their
phones? When investigating
cyber-bullying in school, look
out for these!
As if life wasn’t scary enough for
parents and teachers, here is
another issue to look for and
monitor!
Secret phone apps have been a hot
topic in the news lately about
school students, and they are
definitely something that need to
be brought into the awareness of
those working with them.
The applications are not necessarily
new, but the technology is
constantly advancing.
Private photo vault applications on
smart phones can have the
appearance of very basic images
such
as
calculators
and
calendars.
Once you open the
application, you can enter a secret
code or two, and this is where the
dark side of smart phones can
begin.
Hidden images that students would
not want their parents to see are
being stored and shared by
students.
Students think these
pictures are hidden on the apps,
but there is nothing to say that the
developers of these apps could not
expose the pictures.
These types of news stories have
headlined nationally over the past
year and are raising major
concerns.
How can school staff and parents
spot these vault applications, as
most are seemingly rated ‘E’ for

Secret Phone Apps
everyone?
Look for multiple
versions of the same app on a
child’s phone. The most common
is the calculator app. Also, check
the child’s phone history for new
app downloads and then search
the app with a Google search to
understand its content.
Teenagers
love
similar
applications that may be more
familiar such as Snapchat, Kik, and
Whisper. Again, these are all
popular trending applications
where messages seem
to
disappear
after
a
certain
timeframe—but do they really? A
helpful article is at
https://
www.commonsensemedia.org/
blog/snapchat-kik-and-6-more-iffy
-messaging-apps-teens-love. The
article not only explains several
trending applications, but offers
very helpful information regarding
each application, and outlining
what parents and teachers need
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to know.
You might like to pass the
following helpful hints to parents
and carers (although they are most
likely easier said than done!):


Don’t let your children take
their phones to bed with them
at night.



Don’t let them have a phone
without parental supervision.



If your child uses a family
computer, keep it in the open,
and under supervision.

Again, this is obviously not an easy
subject matter, but it’s one that
can even lead to severe legal
penalties to the students and their
parents. These types of things
may not be the easiest to monitor
or catch, but at least you have a
few more clues on what to discuss
openly with your children. Open
communication may prevent the
issue from even beginning .
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ICT: tips for Microsoft Outlook
Microsoft report that only
around 35% of features in
their packages are regularly
used.
NAHPA’s IT guru
Tandy Hanff gives some top
tips that you might not be
aware about, which can
help speed your work
processes.




Microsoft Outlook is an incredible
piece of software for managing email,
tasks, calendars and meeting
invitations for ourselves and our
bosses – and sometimes there can be
simply so many messages that it can
seem that we spend all day dipping in
and out of our inboxes. Shortcuts can
help speed your working with the
software – so here are some of the
best short-cuts that you might not
know are available.
AUTOMATING
 If you find yourself regularly
performing a particular task then
Quick Steps can save you time.
You’ll find a set of predefined
Quick Steps in the middle of the
Home tab, but you can also
programme your own Quick
steps. Click the drop-down
arrow> New Quick Step to create
a customary programme that can
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categorise, move, flag and delete
messages with a single click.
If you regularly write the same
text you can save it as a Quick
Part for easy insertion into your
emails. Simply highlight the text
in the composer window, then
switch to the Insert tab> Quick
Parts> Save selection to Quick
Parts gallery. In future, when you
start typing the phrase, you’ll see
it pop up as a suggestion – hit
return to insert it in full.
To move messages that don’t
directly relate to you (that you
have only been CC’d into) go to
Rules> New Rules…. Then click
the “Advanced Options” button.
In the Rules Wizard, select
“where my name is not in the To
box” and then in the next screen,
“move it to the specified folder.”

CALENDAR TIPS
 Archive appointments you no
longer need by changing calendar
properties and setting up
AutoArchive: right-click your
calendar> AutoArchive> Default
Archive Settings> Apply> OK.
 If you often need to view the
calendars of everyone on your
team at the same time, you can
create a calendar group. Begin by
clicking Calendar. Then, in the
Manage Calendars group of the
Home tab, click Calendar Groups>
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Create New Calendar Group>
enter the name of the group> OK.
Select the names of the contacts
you want to add to the group>
Group Members> OK.
Outlook can automatically add
public holidays to your calendar
and it has nearly 100 different
locations to choose from so it is
well worth putting these in if you
work closely with offices in other
locations. To add public holidays
go to Options > Calendar > Add
Holidays,
and
choose
the
countries that you are working
with.
To add a second time zone to your
calendar go to Options >
Calendar> Time zones> Show a
second time zone. This is great if
you are setting up meetings with
different countries on a regular
basis.
To create a recurring meeting
invitation for colleagues or
internal employees at your
company, click Appointments. In
the box that appears, enter the
recipients to the meeting, the
meeting name, text that you
always want to appear in the
message body and anything else
that might be relevant. Save it as
an Outlook Template. To retrieve
your saved templates go to New
Items> More Items> New Form.
Under Look In select User
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Templates in File System. Here you
will find your saved templates.
To keep a declined meeting for
your records or to keep it in your
calendar you may Copy and Paste
this meeting (Ctrl+C, Ctrl+V),
decline the original meeting and
keep the copy.
To move emails to a calendar
appointment Right click on the
relevant email and select Move
from the drop-down menu, click on
Calendar and this will open up a
new appointment in your diary
containing the relevant email.

COLOUR CODING
 If you want to highlight your
Executive’s emails so that you see
them as soon as they come into
your inbox you can change the
colour of the subject heading. To
do this go to View> View Settings>
Conditional
Formatting
(or
Automatic Formatting) and select
the appropriate colour.
 Use Outlook categories to help
identify items that are important to
you. By assigning colours to
categories, you can quickly see
what
different
messages,
appointments and tasks relate to.
To sort your categories, click
Categorise> All Categories and
rename the existing ones. You can
change colours, add new categories
and set shortcut keys for each
category here. To add an item to a
category, select it and press the
shortcut key.
CONTACTS
 If you use Outlook and SharePoint
at work, you can see contacts in
your organization. If you have an
account on Facebook or LinkedIn,
you can also use the Outlook Social
Connector to view updates from
those sites without having to leave
Outlook. Click View> People Pane>
Account Settings to get everything
set up.
 Use the Link Contacts feature to
link multiple contact entries for a
person together so that the
information
is
more
easily
accessible. Click the contact you’re
interested in and view their
information by choosing Home>
People. On the right of the screen,

click Link Contacts, and a dialog
will open showing the contact
entry or entries for that person.
In the Search People box type
some identifying information for
that person and Outlook will
return any other contact entries
which may be a match for that
person. If they are the same
person, click on that entry to link
the details.
HANDY TIPS
 Block all future email from a
sender by clicking the Junk dropdown on the Home tab> Junk
email Options. This opens a
dialogue box that lets you specify
what you count as junk and what
you don’t – here you can blacklist
entire domains and even entire
countries.
 If an email sender is not junk but
not relevant at the moment you
can click Ignore. New emails from
this sender will be sent to the
trash folder as soon as they
arrive.
 Outlook can group emails into
conversations, so that a single
click shows all related messages
together. Go to the View tab and
tick Show as Conversations. Click
the Arrange By> View Settings
from the drop-down menu to
configure additional grouping
options.
 To keep your side menu clutterfree, set up certain folders as
favourites. Go to View> Folder
Pane> enable Favourites.
 You can apply retrospective filing
to important messages by
renaming their subjects to make
them easier to find. Open the
email in a new window and click
in the subject line. Delete the old
subject and type the new one in.
Click ‘Yes’ to confirm the change.
 You can create new emails,
appointments, contacts etc. using
the New Items drop-down on the
Home tab. If you don’t want to
delve into the Outlook interface,
right-click on the Outlook icon in
the Windows 7 or 8 taskbar to
open a list offering direct
shortcuts to create any sort of
new item.
 You can use Smart Art in Outlook
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as you would in PowerPoint. Go to
New Email> Insert> Smart Art.
KEYBOARD SHORTCUTS
 Alt+S can be used to quickly send
an email.
 Click Alt+R to reply to all in email
or switch to the work week
calendar view.
 Click Alt+W to forward an email
or switch to the weekly calendar
view.
 Copy any text to your clipboard,
then in Outlook press Ctrl-V.
Outlook creates a new message
(or note or whatever item,
depending on the folder you’re
viewing) containing the text you
have copied.
 Ctrl+1 and Ctrl+2 can be used to
move between the inbox,
calendar, contacts etc.
 Ctrl+G opens the “Go to date”
dialog which can jump to any date
in the calendar.
 Ctrl+M+F9 to quickly start the
Send/Receive process.
 Ctrl+R can be used to quickly reply
to email.
 To quick insert your signature,
Just hit Alt+n, then type “as” and
Enter.
 You can use Outlook’s virtual Post
-it notes for reminders, quick
notes, temporary bits of text or
anything else. Click Ctrl+Shift+N.
SAVING THE DAY
 You can attempt to Recall a
message if you have sent it
accidently, if you act quickly. Go
to Sent Items and double click into
the sent email, then go to
Message> Actions> Recall This
Message. The dialogue box will
give you two options: Delete
unread copies of this message and
Delete unread copies of this
message and replace with a new
message. Remember to tick the
box option Tell me if recall
succeeds and fails for each
recipient.
SAVING TIME
 The Quick Access Toolbar is great
if you use certain actions
regularly. To set up a Quick Access
button go to the top far left on
your home screen and you will
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ICT: tips for Microsoft Outlook
see a drop-down icon. Select this
icon to be presented with a dropdown menu and click ‘More
Commands…’ You will now be
taken to a pop-up box where you
can add or remove Quick Access
buttons.
SCHEDULING
 To defer sending an email: write
your email, then switch to the
Options tab> Delay Delivery. This
opens a requester with a “Do not
deliver before:” field; enter a date
and time, then click Close. After
you hit Send, the message will be
held until the specified time for
sending.
 You can set up bulk emails and
schedule them to send later by
using the delay sending function.
This is great for birthday messages,
team messages when organising a
big event, and thank you’s.
SEARCHING
 Search for an email with a
attachment simply by typing into
the search bar ‘from: Name of
Person has attachment: yes’
 For any search you perform often,
just save the search for quick and
easy future access. Click on Search
Folders in the left navigation menu,
select “New Search Folder,” and
then either use the wizards or
manually customize the search to
your specifications.
 Use the filter option to quickly
search for certain types of emails
such as those with attachments,
those dated within a specific time
period and so forth. Within your
filtered view, you can type into the
regular search box to drill down
further.
STOP BEING HELD HOSTAGE BY EMAIL
 Desktop notifications are pretty
distracting and should be turned
off— but if you want to know when
your boss emails you. you can set
up a rule to allow this. Firstly turn
off all desktop alerts under the Mail
Options, (go to Options> Mail and
then disable the Display a Desktop
Alert option), then create an
Outlook rule to display alerts for
messages from specific people sent
only to you.
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Isipho Admin - the Gift
‘Isipho Admin’ is a brand
new bursary award for
budding PAs in Africa. The
first four recipients of the
Isipho
bursary
were
announced in March 2016:
all four are in full-time
education and aspire to
becoming PAs. The bursary
gives training opportunities
which they would not
otherwise have access to.
The word “Isipho” is Swahili for
“The gift”, and is pronounced “issypoh”. Anel Martin and Teri Wells
are the idea-makers behind this
innovative
new
educational
opportunity, providing training for
the South African PAs of the future.
The scheme is small and hopes to
grow year in, year out. Anel and Teri
write to NAHPA:
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As assistants working
in the
educational field you undoubtedly
understand how vitally important
education is, not only to the wellbeing of an individual but also to
make a positive impact by countering
the ravages of poverty around the
globe. You see students every day and
are
privy
to
their
personal
circumstances including having limited
access to opportunities as a result of
situations they find themselves in,
often not of their own making.

“Education is the movement from
darkness to light” –
Allan Bloom (1930 – 1992)
The situation in South Africa is dire (as
is currently the case in many countries
around the world). Here are the facts:


8.3 million South Africans cannot
find a job.



A university education in South
Africa costs approximately $7400

Isipho Admin - the Gift
(£5,200) per annum and 95% of
South Africans cannot afford it.


45.5% of the South African
population is classified as poor –
10.2 million South Africans are
classified extremely poor by
world classification standards.



The female population in South
Africa is most affected by poverty
and female-headed households
suffer the most.



Levels of poverty in age bracket
18-24 are the most severe in the
country.



78.5% of adults with no formal
schooling are the poorest of the
poor.






Out of a group of 100 Grade 1
pupils, only 40 will reach Grade
12. Of those, 28 will pass matric
and just 4 will enter university. Of
the 4, only 1 will graduate.
Only 10% of matriculants find
jobs.
Approximately 122,000 children
live in child-headed households.
While this is a very small

proportion of children in South
Africa, the number is not
insignificant. These children also
experience more poverty and a
poorer standard of living than
most people in South Africa when
we look at their experience as a
group.
The concept of Isipho Admin was
born out of our passion for our
profession
coupled
with
an
overwhelming desire to assist and be
of services to talented individuals
who would not otherwise have access
to the opportunity of a tertiary
education. As a team we know we
can't change the lives of 8.3 million
people but we can start by helping
our initial four students.

when it comes to opportunities for
employment.
The ripple effect of assisting just one
of these ladies is impacting not only
them but their families and
communities at large. It is pure
coincidence that all the successful
candidates this year were ladies: men
are not excluded from applying.
Our approach to “changing lives” is to
be as holistic as possible providing :


Financial assistance to cover
formal education at a respected
South African institution including
prescribed books and other
recommended study material.



Individual and group mentorship
support for all students. Each
student has been assigned their
own mentor from the group of
‘PA angels’ in South Africa who
put up their hands to assist in this
project. The combined years of
experience of the support team is
over 100 years.



Back to basics education. The
support team will tackle issues
including what is acceptable on

The students for 2016 all come from
very challenging backgrounds and are
supporting either their unemployed
parents or are heading up child
households.
What they do have in common is a
desperate desire to improve their
lives by increasing their skills and the
resultant “opening of more doors”

The four Isipho Admin 2016 recipients (front row), with their mentors in the Isipho team
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Isipho Admin - the Gift
2016 Isipho Admin PA profiles:
Teddy Montsikelelo Mnyakam is an
independent young woman matured
beyond her years. A confident leader
within her community who knows what
she wants from life and demonstrated
that she can negotiate successfully in
order to get things done. Fondly known
to her new friends as the “hustler”, Teddy
is a hardworking and innovative future
PA, eager to learn, has a commitment to succeed and
willing to take on the challenges that will come her way.
Salaminah Leopeng is a friendly and ambitious 19-yearold future PA, who would like to develop
in all areas that pertain to the PA
profession. She lives with her mother who
is a domestic worker and is determined
not be illiterate nor unemployable.
Salaminah is very keen to gain as much
knowledge and skills in order to become a
well-grounded professional PA.
social
media
platforms,
professional dos and don’ts
specific to the PA/EA profession,
making good life choices vs bad
life
choices,
building
and
nurturing your personal brand,
dealing with difficult situations
(conflict management etc.)
The most important thing we are
giving these individuals and their
families is HOPE, with the goal being
to break the cycle of poverty and
unemployment and impact the lives
of these beautiful young people.
Going forward we would like to be in
a positon to offer them financial
assistance with their transport costs
as public transport in South Africa is
appalling and very expensive,
particularly if you have limited or no
income.
In addition the goal is to provide each
student with an “interview” outfit so
they can make a professional first
impression.
The Isipho Admin Bursary is only
made available to learners who want
to pursue a career as office
professionals.
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Iris Athalia Mothwa is a respectful and
determined 25-year-old who plans on
becoming a successful and accomplished
PA. As the head of her home, she is a
true role model to all five her siblings,
two older than herself, three younger. Iris
touched the Isipho teams’ hearts with her
warmth and sincerity, a kindred spirit that
showed us that this bursary will not only uplift her own
self-development, but that of her siblings and community.
Lerato Sikhosana is a gutsy go getter,
diminutive in frame, but big in heart, she
is an intelligent and bright young up-andcoming PA that people will take note of.
Already a leader within her soccer team,
and a motivator within her community,
Lerato is energetic, passionate and
authentic, with a realistic approach to life
and circumstances. She describes herself as an openminded, respectful individual, who is keen to take a
calculated risk, yet takes nothing for granted.

We felt as a team that we wanted to
support and give back not only to our
communities but also to the
profession at large. To the best of our
knowledge this is the only industry
specific bursary of its kind in the
world today.
We hope to be able to create
exceptional EA’s for the South African
market and to provide opportunities
to those who really need them.
Please
visit
our
website
www.isiphoadmin.org.za for more
information or watch our video on
YouTube https://www.youtube.com/
watch?v=NL-mxvZic60
If you feel as passionate as we do
about education and the PA
profession and would like to get
involved there are various ways to do
so.
As is the case with any non-profit
organization we require financial
support but in addition to this we also
need on-the-job training experiences
for our students (office-based work
exposure during vacation time),
subject matter experts who can assist
with their training and preparing
them for the working world, books,
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stationary and laptops. We also
welcome suggestions to add value to
the programme. Perhaps your school
could sponsor a future student?

“He who opens a school door,
closes a prison” –
Victor Hugo (1802 – 1885)
For additional information, contact:
Teri Wells (Isipho
Director)
teri@isiphoadmin.org.za

or
Anel Martin (Isipho
Director)
anel@isiphoadmin.org.za
NAHPA is proud to support the Isipho
Admin programme, with donations of
books, a distance learning course and
Skype mentoring for each Bursary
from editor Angela Garry.
If you or your school would like to get
involved or help fund-raise, please do
get in touch!

Ever made the mistake of
signing off on an email to
your boss with “love” or
“xxx”? How do you end
your emails?
Tandy Hanff looks at a wide
range of sign-offs, not ALL of
which are recommended to
end your emails on a
positive note!
Best – This is possibly one of the best
sign-offs. I recommend it highly and
so do the experts.
My best to you – Etiquette consultant
Lett likes this one. I think it’s oldfashioned.
All the best – Harmless.
Best Wishes – A bit like a greeting
card but it’s not bad.
Best Regards – I’m not sure on this—
can you give anything better than
“regards”? Is there a “best” version?
Regards – Fine, brief. I use this.
Rgds – No, no, no! Why not type
three more letters?
Warm Regards – I like this for
someone you don’t know very well,
or when meant as a thank-you.
Warmest Regards – warmer than
warm?
Cheers – a bit too “out for a drink” for
my liking.
Take care – Ok for personal emails.
Thanks - an appropriate, warm thing
to say. I use this.
Thanks so much – a little “I love you
SO much”?
Thanks! – Exclamation marks rub me
the wrong way, particularly in a signoff like this as it can feel like forced,
rather than genuine.
Thank you – More formal than
“Thanks.” I use this sometimes.
Many thanks – I use this a lot, when I
genuinely appreciate the effort the
recipient has undertaken.

Successful Sign-Offs
Thank you for your consideration –
sounds like you are in the 19th
century still.
Thx – No, no, NO!
Hope this helps – I like this in an
email where you are trying to help
the recipient.
Looking forward to hearing from you–
gracious and warm, and shows you
are eager to meet with the recipient.
In haste – good when you don’t have
time to proofread—or a bit lazy?
Yours truly – I don’t like this. It makes
me feel like I’m ten years old and
getting a note from a pen pal.
Yours – Same problem as above.
Sincerely – Lett also likes this but to
me, it signals that the writer is stuck
in the past. OK perhaps from a lawyer
handling your dead mother’s estate.
-Your name – Terse but just fine in
many circumstances. Probably not a
good idea for an initial email.
-Initial – Good if you know the
recipient and even fine in a business
context if it’s someone with whom
you correspond frequently.
Love – No, no, and no once again.
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XOXO – really? For a business email?
Hugs – It’s hard to imagine this in a
business email but it’s fine when
you’re writing to your granny.
Smiley face - Emoticons are
increasingly accepted, though some
people find them grating. I wouldn’t
sign off this way unless I were writing
to my child.
High five from down low – I’m sorry,
what? An attempt to sound cool,
which fails.
See you around – Lett would cringe
but this seems fine to me.
Sent from my iPhone – This used to
bother me but it explains brevity and
typos. I’ve erased it from my iPhone
signature because I don’t want the
recipient to know I’m not necessarily
at my desk.
Typos courtesy of my iPhone – Ha ha
for the first time. But not for the
second or third...
Please consider the environment
before printing this email. – really? Is
there anyone out there who doesn’t
know that printing uses paper?
Which sign-off do YOU use?
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Don’t plan to fail by failing to plan
Planning, prioritising, goal setting and scheduling: done well, they can make
your job so much easier. Done badly, they can make your whole world seem
so much more difficult….
Terri Fishbourne shares her list of the Top 5 mistakes that people make when
setting goals—and how to handle failure.
Everyone makes mistakes. How often
have you heard that? It’s never been
more important to remember than
when you’re struggling to reach a
goal. Everyone makes them, but they
can be prevented. Everyone wants
success in reaching their goals.
Failure to reach a goal can be heart

breaking, but that isn’t the only
motivation for not making mistakes
when setting goals.
When it comes to setting and
reaching our goals, mistakes can keep
us from success. That’s the whole
reason for setting the goal in the first
place.

Since failure to reach a goal can keep
us from wanting to set another, it is
important to avoid making them when
you’re setting up your goal and
planning the steps you’re going to
take to achieve it.
Here are the most common mistakes
people make when setting goals:

1. Unrealistic goals
This is probably the biggest mistake
of all. It’s good to have big goals
and dreams, but when it comes to
actually setting your goal, you need
to make sure it’s within your reach.
It might be a huge dream. If it’s
something you’re passionate about,
go for it. Just break it down into
realistic goals.
Take it a little at a time. You can’t
run a Marathon if you’ve never run
at all.
Set goals to build up your stamina
and daily training goals to help you
achieve the long-term goal of
running the race.
Eventually, you can reach that big
goal by reaching a lot of little ones.
Setting the unrealistic goal to start
with, however, sets you up for
failure. It makes it way too easy to
give up. You feel, “I can never do
that,” so you stop trying.

2. Calculating the
complete a goal

time

to

When you plan things, they very
often take more time than your
originally thought. Just ask anyone
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who is having their house remodelled and the contractor says
six months tops to complete it, and
a year later, they’re finally finished.
Things happen that are out of your
control sometimes.
Sometimes, for any number of
reasons, things just don’t work out
the way we plan. Things take
longer to complete. When we
don’t reach our goals by the target
date of completion we set in our
plan, it is very easy to give up. It
can make you feel like a failure.
Not reaching a goal in a specified
time doesn’t mean you’re a failure.
Knowing that ahead of time can
help you calculate a time frame for
your goal that’s reasonable.
Add a little extra time to your plan
to make sure you have plenty of
time to complete it. It will prevent
you from feeling pressured to
complete it. Reaching the goal
itself may be difficult enough
without the pressure. If you finish
earlier, that’s great.

3. Setting goals others want for
us
When it comes to your life, it
seems like everyone wants to put
their two cents worth in. You
should do this, or you should do
that…how many times have you
heard those words. Probably more
times than you can count. It’s not
that these people are trying to hurt
you, it’s just that they feel they
know what’s best for you.
Others aren’t living your life, you
are! You have to set your goals
according to what will make you
happy. Sure, there are times your
goals will be based on what your
boss tells you to do. That’s
expected if it’s a work goal. If,
however, it’s a personal goal, it’s
just that…personal.

If you never check your progress on
your goals, it’s very easy for them
to fall by the wayside. Checking
them regularly will often let you
see that you’re ahead of schedule,
and it will give you a reason to
celebrate.
You may feel like you’re getting
nowhere, but when you check your
progress, you’ll see you really are.
It will also give you a chance to
update your goals. Maybe your
priorities have become different.
Maybe you need to extend your
time or alter a sub goal. Goals are
like a tree standing by the water.
They often bend and alter a bit, but
they don’t break. If you have to
change something, do it. The
important thing is to keep track of
your goal until you reach it.

You’ll feel extra good about
yourself for finishing ahead of the
scheduled target date. I’m not
saying give yourself a year when it
should take six months, but maybe
give yourself seven or eight
months to be sure.
There’s no time to throw a pity
party. Once you’ve determined
what went wrong and planned
another way to go after the goal,
you need to forget the past and
reset your focus toward the future.
Sometimes it may be painful to talk
about to someone and you may
not feel like you have the power to
move on. Look back at a time that
was very rewarding for you. Look
at a former success to give you
strength to move forward with a
new focus.
With a new focus, a failure might
not seem like it’s the end. It can
just be a rest area between where
you are and what you want.

Too many times children start out
life with aspirations to be a doctor
or a lawyer just because their
parents want them to. If that’s not
what you want, be polite about it,
but tell them. Set your goal to be
and do what you want…within
reason, of course. Then, go for it!

4. Failing to review progress
Always check to see just where you
are in the steps to reaching your
goal. Document it. Take the time to
review your progress. If you’re
taking a trip, you check your map
or your GPS from time to time to
see where you are and how far you
have to go.
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5. Failing to Appreciate Failures
Not being able to reach a goal
happens sometimes. Does it hurt…
sometimes it does. It’s definitely no
fun, after all, no one likes to fail.
The problem is that some people
accept this failure as a sign that
they are a failure.
Failure is part of the human
experience. The good thing is, you
don’t have to let that failure define
who you are. You should take that
failure, evaluate it, and learn how
you can do better the next time. It
takes courage to get up, brush
yourself off, and try again. If you
do, it will be easier to follow
through on your goals.
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Since failing at goals is a big issue, and
since it’s what keeps so many people
from reaching other goals, here is
what you should do if you fail:

How to handle Failure
Even the world’s biggest optimist can
get discouraged when they fail. Not
achieving that success you want by
failing at a goal can be a difficult thing
to handle. An old song says, “You
can’t always get what you want,” but
it doesn’t mean it doesn’t hurt when
you don’t get it.
Too often, people tell you, “That’s
life.” Why? It doesn’t have to be. You
need to look at that failure
optimistically and look for ways you
can use it to redirect your path and
find another way to approach it.
Failure is just a chance to grow. It’s
time to plant a new seed, fertilize it,
and watch it become something
beautiful. If you look at a road map,
you’ll see there are many ways to get

Angela Garry (Author, PA
Trainer, Editor & Publisher)
reflects on recent months.
The Spring 2016 term was a “term of
firsts” for me— I’ve worked with
international schools throughout Asia
up to now, but this term I had my
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to the same place.
You just have to find the way that
works best for you. When you’re
faced with a failure, here’s what you
need to do:
 Try a different angle
Look at things from a different
perspective. If you can’t see one,
ask a family member or a good
friend to help you. Remember,
your feelings are hurt, and it’s easy
to want only positive feedback.
Don’t just approach your “feel
good” friends. Talk to those who
will give you an honest opinion. It
may be hard not to get upset from
what people say, but you need to
grin and bear it. Don’t just walk off
in a huff, listen to what they have
to say so you can determine
exactly what went wrong, why it
did, and what you can do to fix it.

started moving forward. People are
quick to offer their perspective
sometimes even when you don’t
want it. If that happens, smile, say
thank you, and move on. When
they are offering suggestions, you
may have to look at the problem as
if it’s someone else’s problem in
order to stand there with a smile,
but you can do it. Take out the
good suggestions and toss out the
bad. Look at what happened, find a
way to fix it, and move on.
 Reset your Focus
Focus is imperative to reaching
your goals.
Once you’ve analysed what went
wrong and come up with a way to
fix it, switch your focus to the new
approach.
Reach out and grab the new goal
and give it your complete focus!

 Move forward
Always be open to thoughts and
perspectives that can get you

Terri Fishbourne is an Executive
Assistant who has worked in schools
and industry for 20+ years in the USA.

Editor’s Update
first times working with international
schools in mainland Europe and in
Africa—when I delivered various
training sessions at the Council of
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British International Schools (COBIS)
conference for PAs in Bucharest,
Romania at the beginning of
February, and at the Association of

Editor’s Update
International Schools in Africa (AISA)
Professional Learning Institute, held
in Nairobi, Kenya towards the end of
April.
I always find it so exciting to work
with school PAs and administrative
staff and I encourage them to share
their own expertise at the events: in
Nairobi, for example, we had over
200 years of experience in school PA
roles in the training room, not
counting my own years—this gave
everyone present some great
opportunities for mentoring each
other after the event.

and I’ve continued writing my own. In
the 15 months from March 2015 to
May 2016, I organised the publication
of 15 books through my Pica Books
branding (www.picabooks.co.uk).
The latest include three books for
small children (“Holly the Lolly Van” by
Andy Case, plus two of my own: “My
friend Ella” and “Benton’s Business”),
and my personal life goals journal:
“My ‘ME’ book” which is going to be
followed soon by two sister volumes
for students to achieve their study
goals and for workers to achieve their
professional development goals.

I’m then been home for a few days,
ironing out the last few articles for this
issue before sending it to the printers
and then flying to Jeju—a small
volcanic island off the coast of South
Korea where I’ll be delivering a week
of training for an international school.
Once I’m back, I’m booked for
Manchester and London for a day
courses for school PAs (see page 5).
More dates have this been set for
London (Sept), Birmingham (Nov) and
Leeds (Dec) —contact Osiris and give
my booking code to get full details.
I’ll also carry on writing over July and
August (with a surgery at end of July) ,
on my therapeutic fiction series for

For many of those present in both
Bucharest and Nairobi, these were

Photo: with conference attendees
in Prague, May 2016

the first professional development
events which they had attended in
their roles, and the training was much
welcomed.

I’ve just returned from a PA
conference in Prague (in the Czech
Republic), where I delivered a half-day
workshop on ‘an introduction to
project management’, showing how to
best make use of the many skills
already in your possession to take on
projects without having to attend a
formalised (and quite expensive)
certificated course.
The audience
came from all over Europe—some
were names that I knew from my
networking but hadn’t yet me, so it
was great to finally put faces (and
handshakes!) to the people I’d been in
contact with for several years via
email or LinkedIn—plus it’s always
great to make new connections with
the others whom I hadn’t had any
contact with before.

children and young adults; a biography
of author Helene Hanff, editing a
children’s book for a writer in South
Africa, and my new course for aspiring
writers (helping people to plan, write
and create their own books), as well as
the forthcoming UNIPA magazine
which I think I will hold over for
launching in early 2017 (rather than
push it out for October, not quite
ready). Plus I’ll be off on my annual
trip to Thailand in early October. In the
background there are discussions
about possibilities of courses in North
Wales, Scotland, Ireland, and—wait for
it—Hawaii next year.
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Between these two events, I was a
speaker in London at The PA Show in
March and at the Office* show in
May. At both of these events, I spoke
on the topic of Self-preservation to
prevent burnout—a subject close to
my heart after we sadly lost PA
Trainer Susie Barron-Stubley for took
her own life last November.
I also delivered my “Two ‘how to’
days” course for PAs in Nottingham, I
was the guest ‘expert’ on #Adminchat
(free 1-hr Twitter Q&A for PAs) on 21
April, and I’ve continued working with
a number of people to help them
create and publish their own books,

Have a great remainder of the summer
term, and keep pushing on with your
learning and development.
Onwards and upwards!

School PAs and secretaries have to
deal with two very different kinds of
issues with student behaviour: those
typical, active, inquisitive (and
perhaps unruly) students who move
through the office in the regular
course of the day; and those students
who have been sent to the office for
follow-up with the head/principal due
to overly disruptive behaviour. No
matter which group they fall into, all
students should be expected to
follow the same set of rules, but the
way you as a school staff member
deal with them may be different. You
need to be prepared to enforce the
school’s rules for student behaviour
and be prepared to handle seriously
disruptive students.
Communication is key
When you are speaking to students,
there
are
two
forms
of
communication you can use. They are
alpha and beta commands.
Alpha commands are clear, concrete
and specific, and allow a reasonable
time for behaviour to occur: “John, sit
in your seat on the count of three!”
Beta commands are vague and
wordy,
containing
too
many
directives and not enough time for
compliance: “John, sit down right
now! Why don’t you behave like
everyone else? Don’t say anything
and look straight ahead! You just
won’t be obedient. Come up here and
sit near me!”
Beta commands are typically used
when people feel frustrated and
angry—and should especially be
avoided when communicating with
students who have problems
complying with directions.

Behaviour: everyone’s business
tone of the school and the respect we
give to students set an example of
what we expect back from them.
Here are some strategies:
 Greet every student who enters
the office.
 Get to know students’ names as
soon as possible.
 Set an example of courtesy and
friendliness.

You set the tone for your office much
the same way that teachers set the
tone for their classrooms. Students
are people, too, and they carry a lot
of “baggage” with them when they
walk through the school door. The
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 Do not try to handle it yourself.
Refer it to the head/principal or
behaviour team.
 Speak to the offender(s) in a
courteous but “I mean business”
tone.
 Keep the student where you can
see him or her.

Taking control:
Discipline Strategies

Avoid ‘Never Land’

Handling discipline problems in the
office is a real challenge for office
personnel. You are “responsible” for
the conduct of your students in the
office but you quite often don’t have
the authority you need. Students
must know you have the support of
the school principal to effectively
manage behaviour.

 Never lose your temper.

To prevent and control discipline
problems:

 Maintain notes on problems you
have had with any students and/or
their parents or guardians.

Setting the Tone:
Prevention Strategies

 Avoid threats or physical force.
When a discipline problem is
serious.

 Do not threaten all students for
the transgressions of a few.
 Individual behaviour problems
that do not affect other students
are best handled privately.
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 Never use physical force.
 Never use profanity.
Make notes:
 Keep details about the instances
when you have been asked to
supervise a student sent to the
office for disruptive behaviour.

 Keep track of your ability to
complete your regular assignments
when distracted by disruptive
students left in your care.

We’ve gathered together
some useful links to
resources for you in your
roles in schools. This issue,
we are concentrating on
training opportunities.
There are a huge number of events
taking place worldwide for PAs—the
numbers are growing constantly.
Here’s a selection of just a few key
events in the next few months for
PAs in the UK and beyond. We’ve
tried to look for events for education
PAs if possible—be aware though
that some of these events are for PAs
in any organisation. Put some dates in
your diaries, and get booking!
ACES 2016
10 June 2016
Edinburgh Zoo.

CPD Resources: Training

Scotland’s 9th Annual Conference
and Awards for PAs from all
backgrounds. For the last two years,
the “Scottish PA of the Year” award
winners have been PAs working in
education!
www.mackayhannah.com/
conferences/9th-annual-conferenceand-award-for-executive-secretariesand-pas-in-scotland

8 December 2016 Leeds.

The Meetings Show

6-7-8 October 2016

14-16 June 2016

Venue TBC, Thailand.

Olympia, London.

Three days delivered by Angela Garry:

Annual event for meetings organisers,
which includes a programme of
training / educational sessions for
PAs. NAHPA editor Angela Garry will
be one of the speakers over the two
days. www.themeetingsshow.com

(i) managing your tasks,
colleagues and your self’

Adding Value for School PAs

1 day training course for schools
(CPD accredited) delivered by Angela
Garry. See pg 5 for booking form,
booking code and further details.
www.osiriseducational.co.uk
Essential Management Skills For
International
School
PAs
&
Administrative Staff

your

(iii) managing up: the future of your
role.
added

to

21 June 2016 Manchester
29 June London.

Office* show

29 September 2016 London.

01-02 March 2017

30 November 2016 Birmingham.

Olympia, London.

Details at www.officeshow.co.uk

Executive Secretary Live

(ii) managing projects, problems and
decisions,

Details
to
be
www.ksipd.com

4500+ PAs descending on one venue
over two days. An exhibition with
stands from suppliers, plus free
motivational speaker sessions and
paid training sessions. Book in
advance to register for free to attend
the event, just pay for your individual
training sessions as and when the
programme is released.
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16-17 November 2016 Dubai
17-18 February 2017 Johannesburg
31 Mar-1 April 2017 London
14-15 July 2017 Auckland, NZ
This annual conference started in
London, and has increased with a new
venue each year. The world's leading
international event for senior and
aspiring Administrative Professionals
and Executive Assistants, with the
world’s most inspiring speakers and
internationally renowned trainers for
the Administrative Profession.
Details on all four events are available
at www.executivesecretarylive.com

39

NAHPA
www.picaaurum.com
Training company, offering a variety
of courses for PAs and Admins
working in both education and
corporate settings.
Timetable for 2016/2017 academic
year to be released shortly.
Bespoke courses are also available.

www.admin.org.uk
The
School
of
Educational
Administration & Management offer
a wide range of courses for school
admins.
www.rta-training.co.uk
Regional Training Agency provide a

The Association of Headteachers’ PAs
range of courses at varying times of
year, for Support Staff.

TWITTER: #adminchat
Lucy Brazier runs an hour long weekly
CPD session on Twitter, with guest
experts from the global PA
community. Register for free to
Twitter, search for #adminchat—and
sit back on a Thursday at 6 pm UTC to
follow the chat.
The hour is in the form of a Q&A
session—questions are posed to the
guest expert—and anyone can
participate
by
tweeting
their
questions.
If you miss a session, email Lucy’s PA
Matthew (wantmatthew@gmail.com)

who can send you a transcript.
Angela Garry will be the guest expert
on varying topics on 7 July and 13
October 2016.

BOOKS
“Brave PAs: the ultimate guide to
being outstanding in a tough job” by
Angela Garry
The only CPD book written specifically
for PAs, EAs, secretaries and admin
staff working in education.
Available
from
Crown
House
Publishing,
Amazon.co.uk
and
Amazon.com and bookstores.
Kindle
edition
Amazon.co.uk

available

via

Please forward to us any details of Resources which you’d
like to share with your fellow members.

A name change:

A

s I said in my introductory note on page 2, NAHPA is evolving
and expanding. We’re intent on making the magazine,
website and LinkedIn discussion group as useful as possible to all
of our readers in schools worldwide. With a new sister magazine,
UNIPA, in development for PAs and Admins working in
Universities, it feels an appropriate time to announce a longthought-about name-change from NAHPA to EDPA from the next
issue..
As always, we welcome suggestions of topics for future articles
which you would like to see, plus we also seek articles from our
readership—so if you get the urge to put pen to paper (or finger to
keyboard, or voice to dictation system…) please do! We will
continue to interview at least one reader per issue, to find out
about your roles and experiences of working in your schools.
We’re also creating a panel of readers to call upon for opinions /
thoughts. If you’d like to put yourself forward for any of these,
again, please get in touch.
Don’t think that your voice cannot be heard and that you do not
have a valid contribution to make—all of our readers have
something to offer to each other. Plus contributing will look great
on your own CV / resume, where you will be able to state that you
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are a published author, in the leading publication for
PAs and Admin staff in schools!
All contributors receive an additional printed copy of
the magazine plus a pdf of their finalised article, which
can be appended to future job applications, added to
your CPD folder, share with your boss at your next
Performance Appraisal, etc. Together, let’s make
EDPA the best print resource and online forum for
PAs, Secretaries and Admins in schools worldwide!
To get in touch,
Editor@nahpa.org.uk

just

send an email to:
Angela Garry

NAHPA is published three times per year in the UK by Angela Garry trading as Pica Aurum.
NAHPA Issue 45 / Summer 2016
For subscription details, visit www.nahpa.org.uk or email editor@nahpa.org.uk

